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1 Introduction 

In this installation manual, you will receive step-by-step instructions on how to install eCASE. If 
you are a Windows System Administrator, this manual was primarily written with you in mind. 
However, if you instead hold one of the IT positions listed below, or perform duties related to 
one or more of those IT positions, then this manual is also intended for you. 

▪ Database Administrator 
▪ Development Manager 

▪ IT Technical Writer 
▪ IT Project Manager 
▪ Software Engineer 
▪ Software Tester 

 

A major goal of the eCASE Installation Manual — in addition to guiding you through a successful 
installation — is to provide supplemental information in appendices about eCASE that you will 
find useful and time saving. 

This document does not cover the System Requirements, we strongly recommend that you 
review System Requirements document before installation to understand about eCASE 
deployment architecture and server requirements. The system requirements for the required 
servers referred in this document are explained in System Requirements document. 

1.1 Scope 

The information presented in this manual covers how to install eCASE Version 11.1.0, onto the 
Application Server in a Windows Server, Network Operating System (NOS) environment. Given 
that certain components are essential in completing the installation, topics covered include the 

following: 

▪ Configuring the database server for use with eCASE 
▪ Configuring the file repository server for use with eCASE 

 

This manual does not provide instructions about installing Windows Server NOS. For 
installation details, please consult the appropriate Windows Server installation documentation, 
or your software vendor. 
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1.2 Overview 

eCASE is a robust, web application that helps organizations to create case management 
applications through low code approach. In other words, eCASE helps organizations to automate 
their business processes by automating the entire lifecycle of a workflow, a process referred to 
as a case. 

1.3 References 

The following resources are used as references in preparing this manual: 

▪ eCASE System Requirements Manual 
▪ eCASE Prerequisites Installation Manual 

1.4 Installation Prerequisites 

Ensure the following software applications are installed on the server on which you plan to 
install eCASE: 

▪ .NET Framework version 4.8 
▪ IIS version 8.5 or later 

 
Ensure that the SMTP server is configured, so that emails can be relayed to intranet and 
internet domains. 

(!!) Notes: 

▪ Although you can install eCASE web application, eCASE Admin application, the database, 
file repository and the scheduler service on the same server, distributing them on 
separate servers is highly recommended due to their processing demands on the CPU. 
This installation approach helps eCASE and its essential components to achieve higher 

levels of performance. Please refer to System Requirements document to understand 
about eCASE deployment Architecture. 

▪ For information about how to determine which .NET Framework is installed on your 
server, direct your web browser to the following URL: 

https://msdn.microsoft.com/en-us/library/hh925568(v=vs.110).aspx 

▪ For information about downloading and installing .NET Frameworks, direct your web 
browser to the following URL: 

https://msdn.microsoft.com/en-us/library/5a4x27ek(v=vs.110).aspx

https://msdn.microsoft.com/en-us/library/hh925568(v%3Dvs.110).aspx
https://msdn.microsoft.com/en-us/library/5a4x27ek(v%3Dvs.110).aspx
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2 Step 1: Creating the SQL Server Database 

This section guides you step-by-step through the process of creating a database for use with 
eCASE. Before you install eCASE, complete the steps in this section.  

The type of database you will create in this section for use with eCASE is a SQL Server 
Database. Follow the step-by- step procedures outlined below to create the database. 

To create the SQL Server Database: 

1. Double-click the eCASE folder, and then double click the Server folder. 

2. Right-click the Setup.exe file, and then click Run as administrator on the shortcut menu. 

3. The Help Window displays. Click Configuration to setup the database. 

 

4. On the task panel of the eCASE Configuration window, click Create eCASE Database, and 
then click SQL Server on the short-cut menu. 
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5. In the eCASE Database Server dialog box, type the license key in the License Key box (if 
this box is empty), and then click Continue. 

(!!) Note: The license key is in a file included with the set up CD. If this file is in the same 
folder as the Setup.exe file, the license key will be entered into the License Key box 

automatically. 

6. In the eCASE Database Setup dialog box, do the following: 

a. Type the server name in the Server Name box. 

b. Under Authentication Mode, ensure SQL Server Mode (default) is checked. 

c. Type your SQL Server login ID in the Login ID box, and then type password in the 
Password box. 

d. The SQL Server Login ID is required to have permissions either to create new 
database for eCASE or get the list of databases to select a blank database for eCASE. 

7. Click Next. 
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8. If you are creating a new database, do the following: 

a. Select “Database Name” option and enter the database name 

b. Enter the SQL Server Login ID/Password created and assigned as database owner 
for new database. 

c. Check the Configure Repository check box. 

d. Click Next. 
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9. If you are using an existing blank database, do the following: 

a. Use the Select Database drop-down menu to select a blank database created by your 
DBA. 

b. Click Next to configure Repository. 

10. Please select Repository Type: Native or SharePoint. 
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11. Select Document Search Service option for Native Repository. 

a. If Windows Search Service selected, you have to install Windows Search Service on 
eCASE Application server and Repository root directory location should be 
configured on eCASE Application Server in local drive (For example, D:\DMS). 

b. If eCASE Search Service selected, Repository root directory location can be local or a 
network location (For example, remote file repository location on Server_Name01 
will be configured as, \\Server_Name01\DMS) 

12. Enter the File Storage Area Name, Root Directory (local drive or network location as 
described above) and Capacity in MB. If Root Directory is: 

a. Local Path: Install eCASE Scheduler on eCASE Application Server when eCASE 
Search Service selected. 

b. UNC Path: Install eCASE Scheduler either on eCASE Application Server or on a 
different server. Configure the service with a domain user account and set the Read, 
List Folder Contents, Read & Execute permissions to Repository location. To 
configure eCASE Scheduler Service user account refer the eCASE Scheduler 
Configuration topic. 

13. Click Next to Configure eCASE Authentication and System Account details. 

file://///Server_Name01/DMS
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Field Name Description 

eCASE Login Mode Forms – Standard level of access for the eCASE application; 
this is the default option. 

Single Sign On – Allows the user to automatically log into 
eCASE without prompting for credentials. 

eAuthentication – An authentication service provided by a 
proxy/remote server to other distributed servers, on the 
internet or an intranet; users must submit requests to 
obtain login/logout credentials. 
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Field Name Description 

Membership Provider Database – Login credentials will be stored in the eCASE 
database; this is the default option. 

LdapMembershipProvider – Login credentials will be stored 
and verified by the LDAP server; this option must coincide 
with the Portal application. 

Login The unique identifier that verifies the Admin user’s identity; 
this system administrator user manages the eCASE 
application. 

Password The security credential associated with the Admin user to 
gain access to the application. 

Confirm Password Same as above. 

First Name The first name of the Admin user. 

Last Name The surname of the Admin user. 

Email The email address for the Admin user. 

Time Zone The region that has a uniform standard time; the current 
time zone is selected by default. 

LDAP Server Name The name of the LDAP server. 

Service User Name The identifier given to a user that has access to the LDAP 
server entered as Server name/User Name. 

Service User Password The security credential associated with the Service User. 
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Field Name Description 

Domain The name of the IP resource to access the database server. 

eAuthentication ID An electronic authentication identifier for the Admin user; 
the user must submit a request to obtain an ID. 

eAuthentication Log Out 

URL 

A URL that logs out an authenticated user from the server 

with the specified callback method and user state; the user 
must submit a request to obtain the web address. 

 

14. In the Organization and fiscal year configuration details dialog box, fill out the boxes with 
the requested information, and then click Next. 

 

15. When you receive the “Ready to Setup the eCASE database” message, click Finish. 
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16. When you receive the confirmation message, click OK. 
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3 Step 2: Installing eCASE 

eCASE is installed on the Microsoft Internet Information Services (IIS) web server. 

3.1 Install eCASE 

1. Go to eCASE folder, and then open the Server folder. 

2. Right-click the Setup.exe file, and then click Run as administrator on the short-cut menu. 

3. On the navigation panel of the eCASE Help window, click Installation. 

 

4. On the task panel of the eCASE Installation window, click Install eCASE Application. 

 

5. In the eCASE Application Server dialog box, type the license key in the License Key box (if 
this box is empty), and then click Continue. The Set up new eCASE application option 
selected by default. 
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(!!) Note: The license key is in a file included with the set up CD. If this file is in the same 
folder as the Setup.exe file, the license key will be entered into the License Key box 
automatically. 

6. Read the Welcome to the eCASE Installation Wizard dialog box, and then click Next. 

7. Read the Software License Agreement dialog box, click I accept the terms in the License 
Agreement (default), and then click Next. 

 

(!!) Notes: 

▪ The Next button remains disabled until the option to accept the license agreement is  
selected. 

▪ The Reset button sets the default to I do not accept the terms in the License Agreement. 

8. In the User Information dialog box, do the following: 

a. In the Full Name box, type your first name and last name. 

b. Optional: In the Organization box, type the name of the organization that you work 
for. 

c. In the Product Serial Number box, type the eCASE application serial number (if this 
box is empty). 

d. Ensure Everybody who uses this computer is checked, and then click Next. 
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9. In the Destination Folder dialog box, click Next to accept the default folder in which to 
install eCASE, or click Browse to choose a folder of your choice. 

10. In the Select Features dialog box, click Next to install all features of eCASE. 

(!!) Note: eCASE OData Services and eCASE SOAP Services are not required unless 
integrations with external systems are required. eCASE Application, eCASE Admin, and 
eCASE Scheduler Service must be installed. They can be deployed on same server or on 

different servers in production environments to meet the performance requirements.  

 

11. In the Ready to Install the Application dialog box, click Next. 
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12. When the Updating System dialog box appears, let the installation process run to 
completion. (This process could run for several minutes.) 

(!!) Note: It is highly recommended that you let the installation process run uninterrupted. 
For information about uninstalling eCASE, see Appendix D. 

13. When the eCASE Database Configuration dialog box appears, click Close. The eCASE 
Database Configuration dialog box appears if you selected at least one feature during the 
installation process. You can skip filling out the eCASE Database Configuration dialog box 
at this time. You can configure the database in the next section.  

 

14. When you receive the confirmation message, click Finish. 

 

3.2 Verifying the eCASE Installation 

After installing eCASE, you must next verify the installation. This section guides you through 
the verification process. 

To verify the eCASE installation: 

1. On the task bar, click Start > All Programs > Administrative Tools > Internet Information 
Services (IIS) Manager. 

2. In the Connections panel, Expand the Start Page > Sites > and Default Web Site. 
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3. Expand the eCASE folder. 
4. Locate Manage Applications > Browse Application on the right side of the screen. 
5. Click Browse *:80 (http). 
6. In the eCASE Login dialog box, type your User Name and Password, and then click Sign 

In. 

 

7. Click Help > About eCASE. 
8. Make sure the version is correct, then close the screen. 
9. Exit the application. You have successfully installed and configured eCASE. 

(!!) Note: If you are unable to launch eCASE, try to recreate the database and repository. 
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4 Step 3 (Optional): Installing eCASE Add-on 

Modules 

eCASE add-on modules are not required unless they are required to meet your business 
requirements. The following steps are options; you may skip if they do not apply to your 
application. 

4.1 Install eCASE PDF Editor 

To install eCASE PDF Editor, please make sure eCASE application is installed, then follow the 
steps below. 

1. Open Server folder. 

2. Run the Setup.exe as run as Administrator. 

 

3. Click the Install eCASE PDF Editor under Installation section.  
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4. PDFEditor Setup screen appears. Click Next. 

 

5. In End-User License Agreement, please accept license details and click Next. 

6. In Destination Folder screen, click Next. 

7. At the Ready to Install prompt, click Install. 
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8. The installation progresses. When complete, click Finish. 

 

 

4.2 Install eCASE OCR Components 

eCASE OCR Components should be installed on the same server where eCASE scheduler is 
installed. To install eCASE OCR Components, follow the steps below on the eCASE Scheduler 
server. 

1. Open Server folder. 

2. Run the Setup.exe as run as Administrator. 
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3. Click Installation and click Install eCASE OCR Components. 

 

4. When the confirmation message appears, click Yes to continue. 

5. eCASE OCR Components Welcome screen appears. Click Next. 

6. In User Information screen, please provide the details and click Next. 

 

7. In Destination Folder screen, click Next. 

8. At the Ready to Install prompt, click Install.  

9. After the installation completes, click Finish. 

10. After successful installation of eCASE OCR Components, please Configure the OCR in 
eCASE Scheduler using eCASE Database Configuration. 
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11. Open eCASE Database configuration and select eCASE Scheduler Service in 
Application/Service drop down box and then Save the database configuration. 

 

12. After saving the database details, eCASE Scheduler Configuration screen appears. Click the 
eCASE Optical Character Recognition Service checkbox. 
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13. Click Save and close. 

4.3 Install Document Review Management 

To install eCASE Document Review Management, please make sure the eCASE application and 
the scheduler is installed. 

To install eCASE Document Review Management: 

1. Open Server folder. 

2. Run the Setup.exe as run as Administrator. 

3. Go to Installation and click Install eCASE Document Review Management. 

 

4. Once the wizard launches, click Next to continue. 

5. Select I accept the terms in the License Agreement. Click Next. 

6. In User Information screen, please provide your details and click Next. 

7. In Destination Folder screen, click Next. 

8. Click Install when prompted. 

9. The installation begins. After successful installation, click Finish.  
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10. Next, configure the Document Review Management in eCASE Scheduler using eCASE 
Database Configuration. 

11. Open eCASE Database configuration and select eCASE Scheduler Service in 
Application/Service drop down box and then Save the database configuration. 

 

12. After saving the database details, eCASE Scheduler Configuration screen will appear. Select 
Document Review Management checkbox and Save the Configuration and Close. 

13. Click Save and close. 
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4.4 Enable Find and Redact 

To enable Find and Redact, the steps below. 

(!!) Note: Before executing scripts below, please make sure that the OCR is installed and 

configured.  

1. Copy the FOIAXpress.Utilities.UDFRegExp.dll into SQL Server machine and place the dll 
into C:\temp. 

2. Then, login to SQL Server Management Studio as “SA” and execute the following queries. 
 
EXEC sp_configure 'show advanced options' , '1'; 

GO 

reconfigure; 

GO 

EXEC sp_configure 'clr enabled' , '1' 

GO 

reconfigure; 

GO 

 

3. Lastly, register the FOIAXpress.Utilities.UDFRegExp.dll assembly within SQL Server using 
SQL Server Management Studio by executing the following queries. 
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GO 

CREATE ASSEMBLY RegExP 

FROM 'Provide file path'  

GO 

CREATE FUNCTION dbo.REGEXP_LIKE(@Input nvarchar(max),@Pattern nvarchar(500)) 

RETURNS nvarchar(max) 

AS  

EXTERNAL NAME RegExP.UserDefinedFunctions.REGEXP_LIKE 

GO 
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5 Privileges for eCASE Application Server 

and Services 

The following section lists all applicable directories and their required permissions for the 
application to communicate with the file repository and load the assemblies. The privileges 
outlined in the following sections are relevant to eCASE web application and web pages. 

5.1 Required Permissions for ASP .NET Process 

Identify 

The security permissions outlined below are specifically for the ASP.NET Process Identity (IIS 
Application Pool Identity). In 8.5, the Application Pool Identity by default is set as the 
NETWORK SERVICE user and as the Application Pool Identity user in IIS 8.5 or above. 

If eCASE is configured with Single Sign-On Authentication, both the IIS Application Pool 
Identity users and all eCASE users must have the permissions on files and folders listed in the 
table below. 

If eCASE is configured with Forms Authentication, only the IIS Application Pool Identity user 
must have the permissions on the files and folders listed in the table below. 

ASP .NET Process Identify Permissions 

Location Access type Comments 

%SystemRoot%\Microsoft.NET 

\Framework\versionNumber\ 
Temporary ASP.NET Files 

Read, List 
Folder 
Contents, 

Read & 
Execute, Write 

This is the location for dynamically 
compiled files. Beneath this location, 
application code generation takes 

place in a discrete directory for each 
application. 
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Location Access type Comments 

%SystemRoot%\System32 Read, List 
Folder 
Contents, 
Read & 
Execute 

This contains system DLLs loaded by 
the .NET Framework. 

Program Files\AINS 

eCase\eCase 

-OR- 

Program Files\AINS 

eCase\eCase 

Read, List 
Folder 
Contents, 
Read & 
Execute 

This is the location for application 
files. 

%SystemRoot%\Microsoft.NET 

\Framework\version and 

subdirectories 

Read, List 
Folder 

Contents, 
Read & 
Execute 

ASP.NET must be able to access the 
system assemblies referenced in the 

Machine.config file in the CONFIG 
subdirectory under 

%SystemRoot%\Microsoft.NET\Fr 
amework\version\. 

Temporary Path Modify, Read 

& Execute, 
ListFolder 
Contents, 

Read, Write  

All eCASE temporary files are stored 

in this location. 
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Location Access type Comments 

Program Files\AINS 

eCase\eCase\App_Data 

-OR- 

Program Files\AINS 

eCase\eCase\App_Data 

Modify, Read 
& Execute, List 

Folder 
Contents, 
Read, Write 

This location stores dictionary files 
for Spell Check. 

Program Files\AINS 

eCase\eCase\Images 

-OR- 

Program Files\AINS 

eCase\eCase\Images 

Modify, Read 
& Execute, List 
Folder 
Contents, 
Read, Write 

The enterprise logo and eCASE 
application images will be stored in 
this location. 

Program Files\AINS 

eCase\Reports 

Modify, Read 

& Execute, List 
Folder 
Contents, 
Read, Write 

This is the location where temporary 

application report files are stored 
when processed in the application  

 

The following table outlines permissions for client workstations: 

Location Access type Comments 

User profile directory Modify, Read 
& Execute, List 

Folder 
Contents, 
Read, Write 

eCASE controls will store the 
temporary files before processing to 
the application. 

 



Privileges for eCASE Application Server and Services 
 

 33 

5.2 eCASE Scheduler Configuration 

If the eCASE Database installed with SQL Windows Authentication mode, the eCASE 
Scheduler Service user should be the owner of the database. Make sure to install the eCASE 
Scheduler Service before you start it. The following procedure details how to configure your 
eCASE Scheduler Service to confirm the identity of users before granting access to operate it. 

(!!) Note: The eCASE Scheduler Service user must be a member of the local or domain 
Administrator group. 

5.2.1 Start the eCASE Scheduler Service 

1. Click Start > All Programs > Administrative Tools > Services. The SERVICES screen opens 
with the EXTENDED tab in view. 

 

2. Locate and select eCASE Scheduler Service. 

3. Right click eCASE Scheduler Service and select Properties. The eCASE Scheduler Service 
Properties window opens with the General tab in view. 
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4. Click the Log On tab then This Account. The password fields become enabled. 

 

5. Enter the user name and password for this account, then confirm the password. 

6. Click OK. 
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7. If service is currently running, a popup appears. Click OK. 

8. Restart the eCASE Scheduler Service. 

9. Select Action Restart from the menu or right-click the on service name and select Restart 
from the short menu. The Service Control window appears detailing the progress to restart 
the service. The Status column should indicate ‘Started’ once completed. 

10. Select File > Exit to close the Services screen. 

5.2.2 Required Security Permissions for eCASE Scheduler Service 

User 

Location Access 
type 

Comments 

%SystemRoot%\ System32 Read, List 
Folder 
Contents, 
Read & 
Execute 

This location contains system DLLs 
loaded by the .NET Framework. 

%SystemRoot%\ Temp Full 
Control 

This location used for Web services 
support. 

User profile directory Read, List 
Folder 
Contents, 
Read & 
Execute, 
Write 

This location stores the cache files of 
the Report Scheduler Service. 

%SystemRoot%\ 
Microsoft.NET\Framework\version 
and subdirectories 

Read, List 
Folder 
Contents, 
Read & 
Execute 

ASP.NET must be able to access the 
system assemblies referenced in the 
Machine.config file in the CONFIG 
subdirectory under 

%SystemRoot%\Microsoft.NET\Fra 
mework\version\. 
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Location Access 
type 

Comments 

Program Files\ECASE\Logs 

-OR- 

Program Files\AINS 

eCase\Logs 

Modify, 
Read & 
Execute, 
Read, 
Write 

The application error log and 
configuration files are stored in this 
folder. 

Program Files\AINS 

eCase\eCase\bin 

-OR- 

Program Files\AINS 

eCase\eCase\bin 

Full 
Control 

The application error log are stored 
in this file. 
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6 Sign-On Mode Configuration 

After setting up the application server, you can change the Sign-On Mode that you originally 
chose using the eCASE Database Configuration utility. The following sections provide 
instructions on how to change to different Sign-On Modes. 

6.1 Configure the Application and Access the Sign -

On Mode Tab 

1. Click Start > All Programs > eCASE, right-click eCASE Database Configuration and select 
Run as administrator. The eCASE Database Configuration window appears. Select the 
database type, enter the required information, then click Save. 

 

eCASE Database Configuration 

(SQL Server) 

eCASE Database Configuration 

(Oracle)

 

(!!) Note: The Login Name and Password fields are disabled if Windows Authentication is 
selected for the SQL Server database type. 
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2. Once you save the required information for either SQL Server or Oracle, a confirmation 
message appears. 

3. Click Yes to save the information. Another confirmation message appears. Click OK. The 
Sign-On Mode tab displays. 
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6.2 Change the Sign-On Mode 

Select the Sign-On Mode tab. The following window appears. It shows the Sign-On Mode 
options selected during the database configuration. 

(!!) Note: The different Sign-On Modes vary on how users will connect to eCASE and can 
range from the default username/password connection to a more secure windows domain 
authenticated connection. 

 

1. Click the Sign-On Mode drop-down list and select the desired option. Enter the required 
outlined in Error! 
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Field Name Description 

Sign On Mode Forms - Standard level of access for the eCASE application. 

Single Sign On - Allows the user to automatically log into 
eCASE without being prompted for login credentials. 

eAuthentication - An authentication service provided by one 
remote server to other distributed servers, on the Internet or 
an intranet; users must submit requests to obtain login/logout 

credentials. 

Membership Provider Database - Login credentials will be verified and stored in the 
eCASE database; this is the default option. 

LdapMembership Provider - Login credentials will be verified 
and stored on the domain where LDAP server is located. 

LDAP Server Name The name of the LDAP server. 

Service User Name The identifier given to a user that has access to the LDAP 
server; entered as 

Server name\User Name. 

Service User Password The security credential associated with the Service User. 

Two Factor 
Authentication 

Check the Two Factor Authentication check box, which 
requires users to submit the client certificates along with login 

and password. It shows when Sign On Mode is forms 
authentication. 

When checked, configure IIS to use SSL for eCASE web 
application and select “Require” option for client certificate 
settings. Additional configuration steps required are explained 
in section – “PIV Certificates as Two Factor Authentication.” 
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Field Name Description 

Client Cert Subject Fields Specify the keys (For example: CN, OU, O) in client certificate 
subject for two-factor validation. These key values are 
compared with Authentication ID field for the user. 

 

2. Click Save. A message window appears. Click Yes to change the Sign-On Mode. 

3. Click OK on the confirmation message. 

4. Click Close to exit the eCASE Database Configuration window. 
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6.3 PIV Certificates as Two Factor Authentication 

Please follow the instructions in this document to configure eCASE Two Faction 
Authentication with PIV Card. Some organizations may require having a different server for all 
PIV challenges that is different from application server then it is required to setup second IIS 
server. In second IIS server, do NOT install eCASE application. In this document, PIV Server 
(Second Server) is optional, it is required only when your organization policy requires to have 
a dedicated server. You should ignore PIV Server (Second Server) sections in this document 
when you are configuring with Single Server option. 

In this document Steps 1, 2 and 3 are same for Single Server and Two Servers configurations. 
Step 4.a is for single server configuration, Steps 4.b, 5 and 6 are for Two Server configuration. 

6.3.1 System Requirements for PIV Server (Second Server - 

Optional) 

▪ Windows 2016 Server with IIS 8.5 server 
▪ Install URL Rewrite and ARR IIS Modules. You can download these extensions from 

Microsoft web sites.  

6.3.2 Step 1: Take Database Backup 

1. Access eCASE database server. 

2. Open Microsoft SQL Server Management Studio. 

3. Right-click on eCASE database and take backup. 

4. Once completed, proceed to Step 2. 

6.3.3 Step 2: Install the Latest Service Pack (if not applied) 

1. Access the application server where eCASE is installed Administrator. 

2. Copy the “eCASE v10.1 Service Pack”. 

3. In the main root of the folder, run Hotfix.exe as Administrator as shown below. 

4. Provide the Backup location to take the backup of the Files. 

5. Click Apply. 

6. Confirm that eCASE database is backed up. 

7. Installation wizard runs. 

8. Once Hotfix is installed successfully, click OK. 

9. Proceed to Step 3.  
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6.3.4 Step 3: Install PIV Card Authentication Hotfix 

1. Access the application server where eCASE is installed as Administrator. 

2. Please add the following entries to the web.config file located in eCASE installed 
directory: C:\Program Files\ECase\eCase 

 

 <location path="Banner/Disclaimer.aspx"> 

 <system.web> 

 <authorization> 

 <allow users="?" /> 

 </authorization> 

 </system.web> 

 </location> 

 <location path="NoPIV.aspx"> 

 <system.web> 

 <authorization> 

 <allow users="?" /> 

 </authorization> 

 </system.web> 

 </location> 

3. Thereafter, run eCASE Database Configuration Tool as Administrator. 

4. Select eCASE for under Application/Service.  

5. Click Save. 

6. Go to Sign-On Mode tab. 

7. Check the Two-Factor Authentication and provide subject given from the SSL Certificate.  

8. Click Save.  

 

6.3.5 Step 4.a: Install SSL Certificate and Configure IIS (Single 

Server Option) 

1. Install Server Certificate into IIS and configure bindings for HTTPS on eCASE Application 
Server.  

2. Open the IIS, and configure the following settings: 
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3. Click on SSL option above. 

 

4. Reset IIS. 

 

6.3.6 Step 4.b: Install SSL Certificate and Configure IIS (Two 

Servers Option) 

1. Install Server Certificate into IIS and configure bindings for HTTPS on eCASE Application 
Server.  

2. Open the IIS, and configure the following settings: 

 

3. Click on SSL option above. 
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4. Reset IIS. 

 

6.3.7 Step 5: Install SSL Certificate and Configure IIS (Two 

Servers Option) 

1. Install Server Certificate into IIS and configure bindings for HTTPS on PIV Server.  

2. Open the IIS, and create a new web site with name URLRewrite with HTTPS binding. 
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3. Configure the SSL Settings and URL Rewrite rules as follows: 

 

 

4. Set the SSL Settings and Apply: 
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5. Add a Rewrite rule with Request Blocking template to abort application related traffic, 
except Images and Disclaimer.aspx. Configure the URL blocking rules as shown below. 
Please make sure type, patterns and ignore case button are configured as shown below. 
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6. Add a Rewrite rule with Reverse Proxy template to rewrite the traffic to application 
server. Click Add Rule and enter the application server name to forward request: 
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(!!) Note: Request Blocking rule should be before Reverse Proxy rule. These rules will ensure 
only PIV requests are sent to dedicate PIV server and all application requests are sent to 

eCASE Application server. Second server configuration provides the ability to monitor PIV 
server traffic and ignore the application traffic. 

7. Add a Rewrite rule with outbound blank rule template to rewrite the rewrite the response 
redirect to eCASE app server login.aspx. Click Add Rule and enter the name of the rule as 
‘redirectoutbound’.  

a. Select <Create New Precondition…> from the Precondition drop-down. 

b. Click Add in the dialog that appears. 
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c. Enter {RESPONSE_STATUS} in the Condition input field and 3[0-9][0-9] in the 
pattern field. Click OK. 

d. Select Server Variable from the Matching scope drop-down. 

e. Enter RESPONSE_Location as the Variable name. 

f. In the Pattern field enter regex: (.*)//(.*)/(.*)/(Login.*) 

g. In the Action Value box enter the URL: https://<eCaseAppServer>/eCase/{R:4} 

h. Click Apply. 

i. Outbound rule should appear as shown below. 
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All three rules should be in the order shown below: 

 

 

6.3.8 Step 7: Set the Banner Page location (Two Servers Option) 

Run the following sql query in eCASE database with proper PIV Server name to set the 
banner page location: 

Update EC_CONFIGURATION 

SET CONFIG_VALUE='https://<pivservername>/eCase/Banner/Disclaimer.aspx' 

where CONFIG_KEY='BannerPage' 
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7 Application Maintenance 

This section provides instructions for using the Application Maintenance Repair feature. 
Application maintenance should be performed on the application server and/or the server 
where eCASE components are installed. 

The Repair feature automatically detects missing or corrupt files and copies the missing files or 
copies the original damaged files into the registry and/or installation destination. 

(!!) Note: Preferences stored in the registry may be reset to the default values. 

1. Right-click the Setup.exe file and select Run as administrator. 

2. Click Installation  Install eCASE Application. The eCASE Application Sever window 
appears. 

3. Make sure the Set Up New eCASE Application option is enabled. Locate the License Key 
file included with the setup CD if the license key is not already populated then click 
Continue. 

4. The Application Maintenance window appears with the Modify option selected. Select 
Repair then click Next. 

 

5. The Ready to Repair the Application window appears. Click Repair to continue.
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6. The Updating System window appears and begins the process of repairing and installing 
components. 

 

7. The following window appears after the update has completed. Click Finish to exit the 
Setup Wizard. 



Appendix B: Application Maintenance 

 54 
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8 Cleanup Utility 

8.1 Cleanup 

The CLEANUP utility allows users to remove folders, case and application types, choice lists, 
and documents from the eCASE application. To access the utility, follow the steps below: 

1. Click Start > All Programs > eCASE. 
2. Right-click on eCASE Configuration and select Run as Administrator. The eCASE 

Configuration window appears. 
3. Click the Cleanup tab. 

(!!) Note: Cleanup is applicable only when a new Repository is configured. 
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8.2 Folder Cleanup 

This option will remove folders and data from the eCASE application. Because Folder Cleanup 
is the first option, it is also the default option. 

1. Click Next. 

2. Select one of the options outlined in Table 0-1 then click Next. 

(!!) Note: This tool will not copy the folders and its related document data. 

Field Name Description 

Folder ID The unique identifier for a folder. 

Received Between The beginning and ending dates a task/case was received. 

Closed Between The beginning and ending dates a task/case was closed. 

Case Types The type(s) of requests or documents related to cases/tasks. 

Application Types The type(s) of requests or documents related specifically to the 
application. 
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4. Click Cleanup to remove the folder and data contained in the folder. 

 

5. Click Yes on the verification message to proceed with the cleanup. 
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6. The Cleanup tab changes to display messaging regarding the cleanup process. 
7. The following message appears once the cleanup process has ended. Click OK to close 

the message. 

8.2.1 Case Type Cleanup 

This option removes Case Types from the eCASE application. 

3. Select the Case Type Cleanup option then click Next. 

 

4. Select from the available list then click Next. 
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5. Click Cleanup to clear the selected case types from the application. 

 

6. Click Yes on the verification message to proceed with the cleanup. 

7. The Cleanup tab changes to display messaging regarding the cleanup process. 
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8. Click OK to close the message. 

8.2.2 Application Type Cleanup 

This option removes Application Types from the eCASE application. 

1. Select the Application Type Cleanup option then click Next. 

 

2. Select from the available list then click Next. 
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3. Click Cleanup to delete the selected Application Type. 

 

4. Click Yes on the verification message to proceed with the cleanup process. 
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5. The Cleanup tab changes to display messaging regarding the cleanup process. 

6. A confirmation message appears once the cleanup process has ended. Click OK to close 
the message. 

8.2.3 Choice List Cleanup 

This option removes Choice List(s) from the eCASE application. 

1. Select the Choice List Cleanup option and click Next. 

 

2. Make a selection from the available list then click Next. Use the <Shift> or <Ctrl> keys to 
make multiple selections. 
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3. Click Cleanup to delete the selected choice list.  

 

4. Click Yes on the verification message to continue with the cleanup process. 

5. The Cleanup tab changes to display messaging regarding the cleanup process. 

6. The following message appears once the cleanup process has ended. Click OK to close 
the message. 
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8.2.4 Documents Cleanup 

This option removes Documents from the eCASE application. 

1. Select the Documents Cleanup option. The list box is enabled. 

 

2. Select for the type of document to remove then click Next. 

 

3. Click Cleanup to delete the selected document. 
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4. Click Yes on the verification message to proceed with the cleanup process. 

5. The Cleanup tab changes to display messaging regarding the cleanup process. 

6. The following message appears once the cleanup process has ended. Click OK to close 
the message. 

 

8.3 Export Folders 

The Export Folders feature provides the user with the capability to transfer folders and 
attachments into the eCASE system based on search criteria. Large quantify of folders can be 
exported by batch into the system by compressing the folders and its contents into a ZIP file.  

1. Click Start > All Programs > eCASE. 

2. Right-click on eCASE Configuration and select Run as Administrator. The eCASE 
Configuration window appears. 

3. Click the Export tab. 

4. Select search criteria from the drop-down list and enter the name of the ZIP file in the 
available field. 
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5. Click Browse. The Browse for Folder window appears. Select the location to store the ZIP 
file then click OK. 

 

6. Click Export to continue. A verification message appears indicating the amount of folders 
to be exported. 

 

7. Click Yes to begin exporting folders to the designated destination. The eCASE 
Configuration window changes to display the progress of the export. 
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8. A confirmation message appears once the export completes. 

 

9. Click OK to close the message and return to the Export Folders tab. 

10. Click Close to exit the eCASE Configuration utility. 
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9 eCASE Uninstallation 

This section provides instructions on uninstalling the eCASE Application from the application 
server. 

9.1 Uninstalling the eCASE Application 

The eCASE application can be uninstalled manually or by using the eCASE SETUP WIZARD. If 
you attempt to uninstall the application using the setup wizard, it will automatically detect the 

previous installation and redirect you to uninstall the application. The uninstall process occurs 
on the application server. 

(!!) Note: To manually uninstall the application click Start > All Programs > Control Panel > 
Programs and Features. Select eCASE then click Uninstall. The application will be removed 
from the server. 

1. Double-click the eCASE > Server folders. 

2. Right-click on the SETUP.EXE file and select Run as Administrator. 

3. Click Installation > Install eCASE Application. The eCASE Application Server window 
opens with the Set up new eCASE application option selected. 

4. Locate the License Key file included with the setup CD if the license key is not already 
populated then click Continue. 

(!!) Notes: 

▪ To avoid manual selection of the license key, make sure the license key file is in the same 
folder as the SETUP.EXE file. 

▪ If a previous version of eCASE already exists a verification message will appear. Click Yes 
to uninstall the previous version of the application or click No to exit the uninstall 
process. 

▪ The Windows Installer window appears briefly. After several seconds, the eCASE Setup 

window appears with Modify selected as the default. 

5. Select Remove and click Next. The eCASE Uninstall window appears. 
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6. Review the information on the window then click Next. The Updating System window 
appears. 

7. Click Finish to close the eCASE Setup window once the application is uninstalled. 

 

(!!) Notes: 

▪ The Setup Wizard may detect services that are actively running on the server. When this 
occurs a message window will appear indicating so. Select the appropriate action to close 
the message window to resume the uninstallation process. 
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▪ It is highly recommended not to interrupt the Updating System process. If you must, click 
Cancel. 

▪ The eCASE Setup window will appear. Review the information before proceeding then 
click Exit Setup to stop the uninstall process or Resume to continue with the 
uninstallation. 

▪ Exiting the uninstall process while the system is updating will not remove the entire 
application. You must restart the uninstall sequence of steps to completely remove the 
application from the server. 
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10 Un-installation Steps for eCASE Add-on 

Modules 

10.1 Uninstall eCASE OCR Components 

To uninstall eCASE OCR Components, follow the steps below. 

1. Open Server folder. 

2. Run the Setup.exe as Run as administrator. 

 

3. Click Installation and click Install eCASE OCR Components. 
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4. Click Yes to continue. 

 

5. Click Next to continue. 

 

6. Application Maintenance screen will prompt. Select Remove and click Next. 
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7. Click Remove. 

 

8. Wait for uninstallation to complete. 
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9. Click Finish. 
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10.2 Uninstall eCASE PDF Editor 

To uninstall eCASE PDF Editor, follow the steps below. 

1. Open Server folder. 

2. Run the Setup.exe as Run as administrator. 

 

3. Click lnstallation and click Install eCASE PDF Editor. 

 



Appendix E: Uninstallation for Add On Modules 

 76 

 

4. Application Maintenance screen will prompt. Select Remove and click Next. 

 

5. Click Remove. 
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6. Wait for uninstallation to complete. 

7. Click Finish. 
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11 Troubleshooting 

11.1 Syntax error while accessing the Folder Tabs 

Problem: 

Why is a Syntax error being observed while accessing the Folder Tabs? 

Solution: 

Reset Internet Explorer settings to their default condition. 

To reset Internet Explorer settings follow these steps: 

1. Exit all programs, including Internet Explorer (if it is running) 

2. Click Start, type inetcpl.cpl and press Enter. The Internet Options dialog box appears. 

3. Click the Advanced tab. 

4. Under Reset Internet Explorer settings, click Reset. Then click Reset again. 

5. When Internet Explorer finishes resetting the settings, click Close in the Reset Internet 
Explorer Settings dialog box. 

6. Start Internet Explorer again. 

 

11.2 Failed to decrypt using provider 

'RsaProtectedConfigurationProvider' 

Problem: 

Failed to decrypt using provider 'RsaProtectedConfigurationProvider'. Error message from the 
provider: The RSA key container could not be opened. 

Solution: 

Execute a command to provide the AppPool account of eCASE. 

1. Open Command prompt. 
2. Go to C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727 
3. Execute aspnet_regiis -pa "NetFrameworkConfigurationKey" "Network Service" by 

providing the AppPool account of eCASE. 
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* Network Service is the AppPool account of eCASE if the AppPool account is WINDOWS Domain 
User account, you have to provide like DOMAIN\UserName. 

If the issue persists even after following the above-mentioned procedure, provide the Read, 
Read & Execute, and List Folder Contents permissions for the Network Service User to inherit 
the permissions from the parent to all its child objects on the following Path. 

C:\ProgramData\Microsoft\Crypto\RSA\MachineKeys 

 

11.3 Default NTFS Permissions and User Rights for IIS 

For default NTFS File System Permissions and User Rights for IIS, please refer to the link below: 
https://support.microsoft.com/en-us/help/981949/description-of-default-permissions-and-
user-rights-for-iis-7.0-and-later 

 

11.4 Unable to install application by someone other 

than Initial Installer 

Problem: 

A user wants to perform a fresh installation of the application and removes the previous 
installation using the Control Panel, Programs and Features Uninstall function. Once the 
application is removed a warning message appears when attempting to re-install the 
application: “ eCASE application version (x.x.x.x) has been initially installed by a different user. 
Please log out and re-login with the aforementioned user account to continue with the 
installation of version x.x.x.x.” (‘x’ represents the version number). 

Solution: 

Manually remove the following keys from the registry: 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Installer\UserDat
a\S-1-5-21- 

1522637160-2486600271-3587380157-
4220\Products\3079D6522DDCB1541B9F9E2910894CB7 

 

https://support.microsoft.com/en-us/help/981949/description-of-default-permissions-and-user-rights-for-iis-7.0-and-later
https://support.microsoft.com/en-us/help/981949/description-of-default-permissions-and-user-rights-for-iis-7.0-and-later
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HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\
Uninstall\{256D9703- CDD2-451B-B1F9-E9920198C47B} 

 

11.5 Error uploading large attachments 

Problem: 

Error while uploading large files as attachments into eCASE 

Error: System.Net.WebException: The remote server returned an error: (404) Not Found. 

Solution: 

Follow the steps below to resolve the issue. 

1. Open IIS Manager by selecting Start > All Programs > Administrative Tools > Internet 
Information Services (IIS) Manager. 

2. Expand the Server node > Sites > Default Web Site and select eCASE. 
3. In Feature View, double-click Request Filtering. 
4. In the Actions pane, click Edit Feature Settings. 
5. In Edit Request Filtering Settings window, change the value of Maximum 

allowedcontent length (Bytes).By default, 30 MB is the size. You can increase to your 
desired value. Example: Change the value to 52428800, then application will support up 
to 50 MB. 
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(!!) Note: Please restart IIS after you make the required changes. 


